Angela Garry, A PA with Fantastic Hobbies

Discover How to Motivate Your Manager
Moving Closer To The Paperless Office
PowerPoint Tip - Backgrounds
Our “Day in the Life of ...” Series has been very popular with DeskDemon’s users and we would like to extend it! So, we would like to hear about you and your job and as a thank you we will give you £25 Marks & Spencer vouchers, on publication.

We know from our forum boards at the Hub that networking and support is important to you all. Hearing about each other’s work and offering advice and a helping hand can be invaluable. But not only that, it’s interesting to hear about the experience of others. It put things in perspective and offers us the chance to see how others got to where they are, overcoming challenges and what they think of their role. And what’s why our “Day in the life...” series is so fascinating.

We are looking for Pas, secretaries and Administrators from a wide range of sectors and form the smallest to the largest organisations, so get in touch if you would like to share your thoughts with us all.

If you would like to be featured on DeskDemon’s “Day in the life of ...” series, please visit:
www.deskdeemon.com/pages/uk/career/dayinthelefeof2009
4 Editor’s Letter

7 Discover How to Motivate Your Manager
- 10 Tips for Success

12 Moving Closer To The Paperless Office

14 PowerPoint Tip: The Magic Of False Backgrounds

16 Top Ten UK Holiday Hotspots For 2009

19 Currencies Puzzle
Welcome to the May edition of PA Enterprise. Coming soon. That is a phrase I don’t particularly like to use. In one aspect it is great way to build anticipation for a project, yet when unforeseen delays happen, it can be seen as a deterrent. But as it happens, we have been working on some new projects that if all goes right will be launched very soon. To learn what these projects are, you will have to check the main website of DeskDemon!

Now on to what is in PA Enterprise this month! Our cover story is an interview with Angela Garry. PA to David Harris at Nottingham University Samworth Academy in Bilborough. In this feature Angela shares how she is passionate about her career as well as her hobbies.

For years you have probably heard the future is a paperless office. In reality the business world is far from being paperless but to help move your office in that direction, we have Moving Closer To The Paperless Office. Our next feature is on emergencies. Emergencies Happen When... gives you some tips on preparing for the unknown and how to cope when that emergency does happen. Does your manager motivate you? Discover How to Motivate Your Manager - 10 Tips for Success helps you answer the question: How can I motivate my team when my manager doesn’t motivate me? Finally we have a tutorial piece on The Magic of False Backgrounds, learn a new trick to your PowerPoint arsenal!

As always, DeskDemon is currently looking for PAs, EAs and other office professionals who would like to contribute and pass on their skills and knowledge. If you’re up for it, just email me and I will place you in our database of writers and contributors for future issues. Once again, from everyone at DeskDemon we would like to thank you for comments, feedback and contributions. Feel free to send me an email on what topics you would like to see in the future.

We hope you enjoy this month’s issue of PA Enterprise.

Until next month!

Susan Silva
Managing Editor
susan@deskdemon.com
Fellowes’ step by step guide to workstation set ups.

Fellowes has launched a nationwide Workanomics programme to help prevent work related injuries, such as back pain and RSI.

Workanomics is a step-by-step guide on how to set up a workstation correctly. Workstation assessments are a legal obligation and Fellowes’ aim is to help companies to make the right steps towards creating a healthy office environment. The user friendly Workanomics platform offers ergonomic training, workstation screenings and ergonomic product recommendations to help increase productivity and save costs to the company.

“Businesses have a legal obligation to provide work station assessments and to support a healthy office environment. Investing in suitable desktop accessories from £10 can prevent all manner of devastating office related injuries,” says Kevin Butler from the Board of Certification in Professional Ergonomics.

“With conditions such as thoracic outlet syndrome, carpal tunnel syndrome, tennis elbow and trigger finger, amongst others, frequently attributed to poor posture in the workplace, businesses can no longer ignore the issue,” says Louise Shipley, Fellowes’ ergonomic expert. “Back pain and other musculoskeletal disorders can be prevented by conducting a computer workstation assessment and by taking simple steps to ensure that you are working comfortably.”

The Workanomics guide is available at www.fellowes.com/workanomics

HSE updates its work related stress guidance web site.

The Heath & Safety Executive’s updated web site includes everything you need to know about tackling work related stress using HSE’s Management Standards approach. These cover six key areas of work design that, if not properly managed, are associated with poor health and well-being, lower productivity and increased sickness absence.

There’s updated guidance and advice, new case studies and a brand new self-assessment competency tool for line managers.

For more information visit: www.hse.gov.uk/stress

Altitude 360 Launch Imminent!

Brace yourselves for the Launch of the Century as May 2009 sees the official inauguration of Altitude 360 – London’s premier event space at the top of Westminster’s Millbank Tower.

Since opening in September 2007, Altitude has gone from strength to strength, hosting a breathtaking range of events for many of London’s most prestigious corporations and individuals. So much more than London’s best view, Altitude prides itself on delivering impeccable event experiences from its unrivalled location in the skies above Westminster. Launched by London mayor Boris Johnson, the ‘Altitude 360° concept’ is now due to reach fruition, and will see the venue occupying the entire top floor, doubling the current size of the space. The venue will be able to cater for groups ranging in size from 10 to 600 with equal panache, thanks to the flexibility of the space and its custom-designed moveable walls interspersed throughout the venue. Amazing 360° views over London and her famous landmarks provide the perfect inspirational backdrop for any event.

Altitude 360 also plans to add a full 250 seat auditorium due for completion in early 2009.

For more information: www.altitudelondon.com

Animal Adventure!

ZSL London Zoo, based on the outskirts of Regent’s Park, has launched their new ‘Animal Adventure’ attraction. This mini zoo within ZSL London Zoo itself has private terraces with amazing views of the lions. The space is available for corporate hire during the summer months and is perfect for barbeques, cocktail parties and canapé receptions!

Alternatively you could choose one of their seven other Animal Houses for your event. Popular ones include Gorilla Kingdom, the Reptile House, and the tropical Clore Rainforest Lookout. In order to add even more unique value to your guests’ experience, why not book a live animal encounter for a ‘Meet & Greet’ on arrival?

For more information: www.zsl.org
Discover How to Motivate Your Manager - 10 Tips or Success

By Alan Fairweather

Let me ask you a simple question - does your manager motivate you? If you’re lucky then the answer will be yes. However, when I’m running a seminar for managers and team leaders on team motivation, the comment I hear most is - “How can I motivate my team when my manager doesn’t motivate me?” So the next question is - what are you going to do about it?

One of the best ways to motivate your team is to give them feedback on their performance. You tell them when they do things you do like and you tell them when they do things you don’t like. It’s exactly the same with your manager. Now, I appreciate that we’re getting into scary territory here but you’re going to have to take some action. There’s no point in saying that your manager needs to change because that’s unlikely to happen unless you do something about it.

The rules for giving your manager feedback are almost the same as those for your team.

1. Do it ASAP
   When your manager says or does something you do or don’t like you need to say something right away. If it’s something you do like, it’s not much use saying something weeks later, “Thanks for helping me with that difficult customer last week Dave.” Dave is going to have a bit of a problem remembering that situation and the effect of the feedback is totally wasted.

   It also makes sense to tell Dave about something you don’t like as soon as possible.

2. Do it in private
   You really don’t want members of your team or your colleagues hearing what you say to your manager be it good or bad u
3. Check that it’s okay to speak
Make sure that you have your manager’s full attention. There’s no point in trying to make your point if they have something else on their mind or they’re working on their computer. It’s also good manners and shows respect.

4. Announce your intentions
If your manager is not used to receiving feedback from you, what do you think runs through their mind when you pull up a chair or ring them on the phone - they think it’s bad news, or your about to complain about something or you’ve done something wrong or there’s a problem.

It’s important therefore to tell them up front what you want to speak about.

You might say, “Linda, I’d just like to thank you for something you did today.” Or if it’s something you don’t like you might say - “Linda, I’d just like to talk about something you said today that I’m uncomfortable about.”

5. Tell them how YOU feel about their behaviour
This is nothing to do with any one else. Don’t say things like, “The team don’t like the way you speak to us.” Use lots of “I” messages; say things like, “I’m unhappy with the way you told me how to do that job today. It made me felt embarrassed in front of my team members. Would you be prepared to speak to me in private in future?”

6. Focus on one thing at a time
Don’t confuse your manager with a whole list of behaviours. If it’s things that you do like then you’re in danger of coming across as patronising. If it’s things that you don’t like, then it may come across as a whinger.

7. Be specific
When you’re giving your manager feedback it’s important to focus on job related behaviour and not on the personality of the individual. If you feel a bit uncomfortable, try to focus on the manager’s behaviour in terms of how they said or did something. That’s what you’re giving feedback on, not them as a person.

It becomes easier if you’re using “I” messages and being very descriptive about what you’ve seen or heard. You could say something like, “I liked the way you showed me how to layout that report - thank you Jeff.” Or, “Jeff, I’m concerned by the way you told me how to do that report. It’s important for me to get it right, would you be prepared to spend a bit more time explaining what you require?”

8. Include the customer and the organisation
Whenever appropriate; relate what your feedback is about to how the customer or the business could be affected. This of course could be an internal or an external customer.

9. Get input
When giving constructive feedback, it’s important to get the manager’s input. You might say - “I’m unhappy with the number of tasks you’ve asked me to do this week and I’m concerned that I may not be able to do them in the best interests of the business. However I’m willing to listen to what you have to say and discuss how we can make efficient use of my time.”

10. Don’t leave them low
This is particularly important after giving feedback on something you’re not happy about. This isn’t an attack on the manager; it’s about job related behaviour. Think about how you feel when one of your team speaks to you about something they’re unhappy about. It can leave you low and possibly stressed. Some years ago after a particularly “difficult” meeting with my sales team I was feeling a bit low. However, at the end of the meeting one of the team said, “Alan, we’re all going for a beer and we want you to join us. We have no hard feeling towards you and we like you as our manager.” You can bet that made me feel good.

There’s still a culture in some organisations that doesn’t allow the boss to be challenged. It’s a case of “The boss tells me what to do and it’s my job to do as I’m told.” It’s also the case that some managers don’t want to say anything to their boss for fear of being perceived as negative or a whinger.

Be brave and give your boss some positive feedback. The occasional compliment or descriptive thank you will work wonders for your relationship. And if the boss is doing or saying something you don’t like, give him or her some constructive feedback using the rules above. If you follow these rules, then you’re much less likely to be seen as a whinger.

Alan Fairweather - The Motivation Doctor - is a professional speaker, author and business development expert. To receive your free newsletter and free ebooks, visit: http://www.themotivationdoctor.com
A fascinating career in education, training and recruitment, a splash of online networking and a passion for music have led Angela Garry to her dream job as a PA to David Harris at The Nottingham University Samworth Academy and one of the most influential Principals in the UK.

Hi Angela, can you tell us a bit about your background?

I’ve worked in several different industries, but something in me keeps coming back to education – it’s an area I love and am deeply interested in. I had a couple of inspiring teachers at school and decided to take a teaching degree to try to do what they did – to inspire others to learn. I graduated from the University of Exeter (in the south west of England) in 1991 with a degree in Mathematics and Education, and Qualified Teacher Status. I enjoyed the degree course immensely – but there was one problem: when I went out on teaching practices into schools I didn’t feel that teaching came naturally to me – it just didn’t feel ‘right’. After graduating, I took a temporary admin role at the local water company, and ended up staying there for three years – slightly longer than the original three week contract!

In 1994 I found a role that really suited me – back at the University, in the teacher training college where I had studied for my degree! I was the Senior Secretary to one of the University’s three Deputy Vice Chancellors, Professor Mary John, who was the first woman to have been appointed to an established Professorship at Exeter. Whilst I was working for her, she was nominated for Businesswoman of the Year. The Professor’s role within the University was huge, and her subject specialism was equality – particularly children’s and women’s rights. Part of my role was to help editing several books in her “Children in Charge” series (http://www.jkp.com/catalogue/index.php/ser/childrencharge) which followed her highly successful conference on the UN Convention of the Rights of the Child. Alongside the books and her DVC work, I also assisted in organising two more conferences for her – not forgetting that my job also included running a secretarial office which served a total of 17 academics and being in charge of two other secretaries. I always joked at that time that I worked for 7 academics – one of whom took up 80% of my time, and the other 6 took up the other 80%! When Professor John announced in 1996 her intention to move to Germany with her husband, I knew that my role would diminish, as her Deputy Vice Chancellorship would pass to someone else within the University and I knew that it was time for me to move on too...

For the next three years I was the Company Administrator and Personal Assistant to the Directors of a training company that helped people with disabilities to find a place in the workforce. During this time, I continued to work for Professor John on a freelance basis, organising her world lecture tour in 1998 and editing more volumes within her series u
of books. It was also during this time that I bought my first home – an upstairs flat in a converted Georgian house, but I dreamed of owning a house with a garden for my dog. This was out of my price range in Exeter (where I had now been living for thirteen years since starting my degree course), so I looked for a change of scenery to somewhere where I could buy a house. I moved to the Republic of Ireland in September 2000, taking a temporary role as Administrator for the Higher Education Equality Unit at University College Cork, working with all of the third level institutions throughout Ireland on equality issues relating to staff and students. This job was my ‘stepping stone’ into a new life in Ireland, and within a few months I had secured a permanent role as PA to the Chief Executive at the Shannon Foynes Port Company, one of the major seaports in the country. Over the next four years I organised two major conferences, was promoted to I.T. Team Leader, put together several successful multi-million Euro tenders, and worked for three successive Chief Executives – a very busy role at a time of huge change for the port company.

During 2004 though, I found myself growing more and more ‘homesick’ for England, and in the summer of 2005 I bit the bullet, put my house on the market, got a buyer for it within 8 days (which told me that it was indeed fated for me to move!), and I moved back to England in September 2005. I settled in the East Midlands, near the cities of Derby and Nottingham, and after a three-month temporary job that enabled the move, I secured a permanent role with CNA, an Executive Search company, as PA to the Managing Director.

Having covered many aspects of recruitment during my career up to this point - from advertising for a role up to interviewing and issuing contracts of employment - this was a great opportunity for me to learn a different approach. CNA recruiters worked as head-hunters for the crème de la crème, placing them in high-powered (and high-salaried) roles around the UK and Europe. I assisted in the training process, producing training manuals and DVDs for the group’s 23 international offices, and, as had happened previously in other roles, became renowned as the person to turn to for I.T. support.

In May last year, I was told by a friend about an advert for a job that tied together pretty much all of my working experiences so far – working in education, at a brand new school linked to a University and a successful local businessman, as PA to one of the most influential Principals in the UK. How could I not apply for it? The more I researched the role, the more excited I got about it. I put in an application, crossed my fingers – and got an interview – and the job.

Your current job sounds like an exciting experience. Can you tell DeskDemon’s readers about your current position, how long you have been on the project, what your role is, and how it going?

I started my current role at the beginning of September last year – as PA to the Principal for a new Academy which is due to open this September.

The Nottingham University Samworth Academy (http://www/nusa.org.uk) will be a school for 11 to 19 year olds in Nottingham, focusing on Health and Science, and is jointly sponsored by the University of Nottingham (http://www.nottingham.ac.uk) and David Samworth – the retired Life President of Samworth Brothers food company (http://www.samworthbrothers.co.uk), who are co-sponsoring three city academies in Leicestershire and Nottinghamshire as a private donor.

The involvement of the University and Samworth Brothers is incredibly exciting for our Academy, as we have a wealth of knowledge to bring into the lives of our pupils. In 2010 we will have a new £24million building, and the Academy will be opening this September in the revamped buildings of the predecessor school which is currently on the site.

I work for the Principal, David Harris, who is a fantastically inspiring person to work for, and the last few months have been an absolute blur of activity. This has included recruiting new staff, creating new policies and procedures, holding open evenings for prospective pupils, creating web pages and advertisements in-house (I’ve learnt new skills which have saved several thousand pounds rather than outsourcing these tasks to other providers), and I absolutely love it. It’s the most exciting venture I’ve ever worked in – with a fantastic team of people who are deeply committed to making the Academy a huge success for the pupils, parents and the local community.

It definitely sounds like a fulfilling job. In addition to your job, you are an active online Networker. What started you on online networking and how do you use it?

I started networking online two years ago when the Managing Director at CNA encouraged the staff to network. I realised fairly soon that if...
you are networking in order to build a business, particularly in the area of recruitment, the size of your network is very important. In order to seek out the very best candidates, you can’t just rely on asking the people you know – you need to be able to ask a much larger number of people to find out who they know. In order to help the recruiters at CNA, I started to connect with more and more people online, including administrators and PAs. I created two groups for Executive Search consultants and for ‘PAs, EAs, VAs and Administrators’ – both of which enable the members of the groups to contact each other directly and discuss issues.

I would think with all that you don’t have time to do much else, but you are also in a band! It is important to have a good balance between work and relaxation. Can you tell us a bit about your band?

Music is a passion of mine and has been for many years. I’ve sung in stage shows, competitions and karaoke since I was about 24 – but it’s only been in the last two years that I’ve taken it a step further. I’m currently the lead singer with a band called Live It Up, and have just created the website for the band (http://www.live-it-up.org). We play covers of Motown, rock and roll, and pop songs, for weddings and corporate functions. We rehearse on Wednesday evenings and play most of our gigs on Fridays and Saturdays, and we’re getting booked up fast for this summer.

There are five of us in the band – and I have by far the shortest history of being in a live music situation - Clive, the drummer, has played with numerous bands since the 1960s; Paul on keyboards has worked with Clive for the last eighteen years; Chris (bass) and Geoff (lead guitar) have played bass in many bands over the last 20 years – I’m the newcomer, and I’m going to hit 40 this August.

It’s been a while since I’ve been a newcomer at anything! It’s one thing to sing to backing tapes and karaoke discs, but it’s something else entirely to be part of a live band, creating and changing the music to fit the mood of the audience. My favourites among the songs that we cover are “Mercy” by Duffy, “Son of a Preacher Man” by Dusty Springfield, and Diana Ross’s “When You Tell Me That You Love Me”. More clips of my singing are on my myspace webpage: if any of your readers happen to be friends with Simon Cowell, I’d be very grateful if they would please give him my URL – http://www.myspace.com/angelagarryuk!

That is great! Do you have any suggestions or words of wisdom for other PAs/admins on the importance of having a balance in their lives?

As well as my job and the band, I also spend a lot of time with my dog (a seven year old Westie called Sam), and am busy researching and writing a book about the late author Helene Hanff with whom I corresponded with during the 1980s and 1990s. I think it’s hugely important to have more than one string to your bow – and to have interests outside of work that can make you feel really fulfilled, and which you can bring into your working life also: I’m eager for the Academy to open this September so that I can assist the team at Sharp Records – the UK’s first record label run by students which was set up at the predecessor school two years ago (http://www.sharprecordsmusic.com). The new purpose built Academy buildings will include a full recording studio and video suite when it opens next year – and I can’t wait to be involved.
Moving Closer To The Paperless Office
By Steve Shaw

The paperless office has been talked about for a long time, yet never seems to even start to become a reality in almost any sector of business. Look around any office environment and you would be forgiven for thinking that the opposite of the paperless office is evolving, with ever increasing stacks of printed reports and greater need for filing and document storage than ever before. Most companies, and their individual employees, still hold the opinion that copies of documents still need to be retained ‘on file’ to see and read and a continued mind-set of mistrust of digital storage prevails. This is assisted by many government departments inflicting legal requirements for specific accounting and administrative documents being retained and available for inspection for periods of up to six years beyond their production.

All of this document production and storage is occurring in a time when almost everything we generate comes from a digital system, eg. word processing, accounting systems, digital copiers, etc. - and most of these documents are already stored in digital file format on the system that created them originally (Word files, spreadsheets, photographs, accounting systems, etc). Yet there is still a great reluctance to take the final step and commit these paper files into a concise digital filing system and reduce the amount of environmentally damaging paper consumed, as well as reducing the expense committed to vast amounts of wasted space given over to document storage. Much of the resistance to change stems from old and somewhat flawed technology being made available before its limitations were determined. Those who tried digital document storage in its infancy had poor experiences, with Optical Character Recognition (OCR) and poor scanning facilities producing less than accurate results in the stored documents; bad characters, poor formatting, etc. The previously poor experiences, coupled with localised, instead of centralised, file access has created a resistance to change that still prevails today.

Try the exercise of breaking down the requirements for a digital, therefore paperless, document storage and management system. The majority of businesses will store correspondence, reports and other items produced on a computer-based word/presentation/numeric software program, accounting and auditing documents produced by a computer-based system, email and fax documents transmitted on most occasions via a computer or digital software - and all of these have one thing in common: they are already stored in digital format on the system that was used to create them. Additionally, photographs are either transferred from a digital camera/phone/download/email attachment or scanned (with very good results) into a digital format onto the company’s computer network, so these too are already stored in a digital format.

Other documentation, generally received from external sources (customers, suppliers, etc.), will not have an existing digital file format in your business’s computer - these can be scanned into the system and digitally stored with great accuracy using the advanced software that is now available, and retrieved with accuracy when needed for further reference. So almost 100% of the documentation that your business
uses every day can be stored in a digital document storage and retrieval system; eliminating the need for stacks and files of papers; cutting the need for expensive storage space; reducing wasted employee time searching for those elusive mis-filed documents.

So why are businesses resisting the paperless office? In addition to any previous poor experiences with early technology, the primary reason seems to be a lack of coordinated facilities. Most companies have a networked computer system, many have digital copier and printer systems and most have scanning facilities. However, the file storage systems are fragmented and often personalised, the copier/printer facilities are not correctly networked and scanning facilities are sometimes inadequate and localised.

The resistance towards introducing and operating a paperless document storage and retrieval system is often due to a simple lack of coordination within the business itself, coupled with a lack of responsibility - is it the overburdened IT manager’s job, the office manager’s job, the director responsible for admin’s job, or the ‘Mr Nobody’ who gets lumbered with those tasks no one else has time or incentive to undertake? Yet a great deal of wasted time and money continues to drain from the business resources while this task remains unaddressed.

A straightforward approach to addressing the introduction of a paperless office can have the whole process introduced in little time with comparatively small set up costs, quickly recouped by the savings generated from reduced paper consumption, reduced storage space and wasted employee time.

In terms of personnel, one person should be appointed the task of overseeing the implementation of the system and ensuring that the (probably existing) equipment facilities are correctly networked together into the central business computer network.

A reliable and efficient document storage and retrieval software system should be sourced and installed onto the business’s network and set up ready for use by everyone who handles documents as a part of their daily routine. Having created this hardware and software environment, the task of transferring/installing existing files and documents (historical documents already stored elsewhere) should be undertaken prior to the central document filing and retrieval system becoming ‘live’ (although this could be done retrospectively over a period of time if necessary). The final stage is to roll out the system to all employees from a predetermined date, allowing for any training/instruction being implemented beforehand.

The software for digital document storage and retrieval is the key to its success. Scanning, Archive and Retrieval systems have been viewed by some businesses as a ‘dark art’ or at least with some doubt and suspicion in the past, where poor experiences of older and less stable systems have caused problems with document retrieval. By combining the facilities of the office digital copier/printer/scanner systems (often referred to as Business Hubs due to their networking capabilities), with the networked computer system a good quality software digital document and retrieval program will allow you to store and find that illusive “needle in a haystack”. A quality system will incorporate fast scanning speeds, excellent search and

OCR (Optical Character Recognition) tolerance, automatic document indexing, fast search and retrieval facility with efficient and easy to use Boolean search commands (Google style searching). One such system is PowerRetrieve, available through Business By Technology Ltd., UK, along with fully trained and experienced consultants and IT advisors.

Three definable supplier areas are clear for the introduction of a paperless office environment: the networked computer system, the digital office copiers/printers/scanners, and the document storage and retrieval software. Each of these areas have their own specialist advisors who can be called upon for advice and assistance, but some supplier companies, primarily from the office copier/printer sector, now have specialist trained IT advisors who can coordinate the introduction of a paperless office system from inception to completion. A specialist IT advisor from one of these companies is of great assistance when working alongside the internal person charged with responsibility for introducing the paperless office system, from the early planning stages through to final implementation. The paperless office is within the grasp of every business, however large or small, it can create a more efficient working environment and immediately recognisable cost savings from implementation.

Article by Steve Shaw, of Business By Technology Digital Document Storage & Retrieval, Manchester. The website http://www.photocopiermanchester.co.uk offers advice and information on selecting the right software and BizHub equipment for your office.
Glen Millar, of Glen Millar Communications, introduced this animation/Graphics technique at the PowerPoint Live conference. He called it the False Background. It isn’t really a false background, but uses the technique of giving an AutoShape (shape, in 2007) the same background as the slide. You can then animate the AutoShape/shape, or layer it, for some stunning results. Follow these steps to set up this technique:

1. Start with a blank layout on an empty slide.

2. To specify a background image, right-click the slide and choose Background. (In PowerPoint 2007, choose Format Background.)

3. Click the drop-down arrow and choose Fill Effect. Click the Picture tab. (In 2007, click the Picture or Texture Fill option.)

4. Click Select Picture, and specify an image for the background. (In 2007, click the File button to specify an image.)

5. Click Apply. (In 2007, click Close.)

6. On the Drawing toolbar, click AutoShapes and insert one of the AutoShapes. (In 2007, click the Insert tab, click Shapes, and insert one of the shapes.)

7. Right-click the AutoShape (shape, in 2007), and choose Format AutoShape (Format Shape in 2007).

8. In the Line section, click the Colour drop-down list and choose No Line, to remove the outline. (In 2007, click the Line Colour item on the left, and choose No Line.)

9. In the Fill section, click the Colour drop-down list and choose Background. (In 2007, click the Fill item on the left and choose Slide Background Fill.) This sets the fill of the AutoShape (shape) to the background of the slide. This is the very essence of this technique.

10. Click OK. (In 2007, click Close.) The AutoShape all but disappears, except that it’s still selected, so that you can see the handles. Look at the
Technique 1: Zoom In

In this technique, you use the Zoom In emphasis animation to zoom in to a section of the image.

1. In Step 6 above, insert a circle or ellipse and centre it over the area of the image that you want to emphasize.
2. Continue with the rest of the steps above.
3. After Step 10 above, with the AutoShape/shape still selected, choose Slide Show> Custom Animation. (In 2007, click the Animations tab and choose Custom Animation.)
4. Choose Add Effect> Emphasis> Grow/Shrink. Leave the default of 150% or choose another option.

Technique 2: Crop an Object

By layering AutoShapes (shapes), you can create a cropping effect. This effect can be static or animated. This is one of the effects that Glen showed at PowerPoint Live.

1. Before Step 6 above, insert a rectangle that covers the entire slide. It can be opaque, or partially transparent. Remove the outline and choose an appropriate fill colour.
2. In Step 6 above, insert the shape that you want to use for the cropping. I used a rounded rectangle. Centre it over the area of the image that you want to display. By doing these steps in this order, you’ll ensure that the smaller shape is on top of the larger one.
3. If you want, you can animate an entrance for the larger shape covering the entire slide. Here, I used a Fade entrance animation.
4. Continue the rest of the steps to fill the top shape with the background.

Technique 3: Mix Grayscale with Colour

Like the previous technique, this one layers shapes. The outside area is grayscale, and the area inside the shape is in colour. Glen showed this technique, too. I’ve left it unanimated.

1. Before Step 6 above, choose Insert> Picture> From File and insert the same image you used for the background. (In 2007, click the Insert tab, and choose Picture.) If necessary, resize it to cover the entire slide.
2. If the Picture toolbar isn’t displayed, right-click any toolbar and choose Picture. Click the Colour button and choose Grayscale. (In 2007, click the Format tab that appears. In the Adjust group, click Recolor and choose Grayscale in the Colour Modes section.)
3. In Step 6 above, insert the shape that you want to use for the cropping. I used a rounded rectangle. Centre it over the area of the image that you want to display. By doing these steps in this order, you’ll ensure that the smaller shape is on top of the larger image.
4. Continue the rest of the steps to fill the top shape with the background.

Technique 4: Fly In the Image

Glen showed this animation as well. The image is broken up into 4 pieces which fly in and build the image, like a jigsaw puzzle. You can vary the animation effect in any way that you want. You can also add thick outlines around the 4 shapes.

1. For Step 6 above, insert 4 rectangles that together completely cover the slide. Here you see the rectangles with thick outlines to help you see their borders. I then removed the outlines.
2. Continue through the rest of the steps above for each of the 4 rectangles.
3. Select each rectangle in turn and add the following animation.

* Top-Left rectangle: Fly In from Bottom-Right, On Click. I used the Medium speed.
* Top-Right rectangle: Fly In from Bottom-Left, With Previous, same speed as before
* Bottom-Left rectangle: Fly In from Top-Right, With Previous, same speed
* Bottom-Right rectangle: Fly In from Top-Left, With Previous, same speed

This article in its original form may have included images and/or other media.
Top Ten UK Holiday Hotspots For 2009

By Julie Samuel
As the credit crunch continues to bite, sunning yourself on a beach with a cocktail in hand can sometimes seem like a pipe dream. According to the latest research from the Confederation of Passenger Transport (CPT) twice as many Britons are planning to spend their holidays in the UK this year compared with 2008. The survey of 3,000 British adults showed that 60 per cent of those interviewed were unwilling to give up holidays and are set to explore the British Isles. But where are the best, most exciting and unusual places to go on your doorstep. Check out our top ten guide below for the UK’s hotspots:

10. Liverpool

The European Capital of Culture boasts some amazing sights when you venture off the tourist track. Keep a special eye out for the towering features of the Three Graces on Liverpool’s waterfront, the two impressive cathedrals situated on each end of Hope Street and the Radio City tower.

9. Cambridge

The intellectual hotspot of Cambridge is a delight to visit in any season: you can relax in its many pubs, restaurants and cafés or explore the independent shops around the historic market place. There’s a brand new shopping area too, with all the high street favourites that you would expect.

8. Bath

As a world renowned World Heritage Site, Bath boasts some of the most famous architectural masterpieces in Europe such as the Roman Baths and Pump Room, Royal Crescent, Bath Abbey and Pulteney Bridge. But that’s not all - the city also has world class museums, theatres, festivals, parks, restaurants and any number of quality shops. Bath is not only a beautiful spot to relax and reflect, it is also a perfect base for exploring the surrounding...
countryside of North East Somerset and the Cotswolds.

7. Cardiff

As the Capital of Wales, Cardiff is a city with both heritage and ambition. The city has a distinctive character, a good quality of life and a growing national and international reputation. It presently plays host to numerous large and high profile events, including Britain’s largest free summer festival and is home to many national institutions, including the National Museum of Wales and the much-admired Millennium Stadium.

6. Brighton

Brighton is viewed as one of the most vibrant, colourful and creative cities in Europe. Compact, energetic, fun, lively, historic and free-spirited, it’s a city like no other. Nestling between the South Downs and the sea on the south coast, Brighton offers everything from Regency heritage to beachfront cool.

5. Edinburgh

As host of the world renowned summer festival, Edinburgh is steeped in history and a thriving cultural scene. With Scotland’s most famous castle dominating the city skyline, Edinburgh blends traditional and contemporary style perfectly. A labyrinth of mysterious winding streets, elegant terraces and an abundance of shops and restaurants makes Edinburgh an ideal getaway for a relaxing and lively break.

4. Isle of Wight

The Isle of Wight is situated about five miles off the south coast of the English mainland and resembles a diamond in shape. There is over 60 miles of coastline, which ranges from award winning beaches to spectacular chalk cliffs. A wide range of activities are available on the Isle of Wight, covering just about anything. The area is renowned for its extreme sports, with a huge variety on offer, including surfing, water skiing, land yachting, diving, windsurfing, jet skiing, paragliding and kite surfing.

3. Norfolk Broads

The Norfolk Broads is now the UK’s largest nationally protected wetland and an important area for wildlife. A holiday in the Norfolk Broads is like a whole new world. And it’s easy. No complicated locks to manoeuvre, just 125 miles of navigable waterways with plenty of places for you to moor up and hop out to explore pretty villages and market towns, or to stop at a welcoming pub to set you up for the rest of the day.

2. London

The infamous cosmopolitan city that is London. A place rich in culture, history and heritage whilst always maintaining its status as an icon of style, charisma and excitement. London is home to some of the world’s most famous attractions and landmarks including Buckingham Palace, Piccadilly Circus, Big Ben and The London Eye. By day, this city offers everything from world class museums to the best in shopping on Oxford Street and the glamorous Kensington. By night, London really comes alive with its wide array of restaurants, bars, clubs and theatre shows at the Westend. Indeed London is a city to suit every individual.

1. Lake District

The Lake District National Park is famous for its stunning scenery, abundant wildlife and cultural heritage. The lakes and tarns give the Lake District a quality of scenery and recreational resource found nowhere else in England. You can walk, cycle and splash about in the beautiful Lake District to your heart’s content. With more than 3,500 kilometres of rights of way and twelve of the largest lakes in England, there’s something for everyone. If stunning scenery, amazing wildlife and an air of adventure is something that appeals to you, then Center Parcs’ Whinfell Forest, which is located on the edge of the Lakes, is the ideal [http://www.centerparcs.co.uk/short break that brings all of the elements of the great outdoors into one superb forest retreat. ]
World Currencies

Find the words within the graph

PESO  DOLLAR  LEMPIRA  TALA
EURO   SHILLING  YEN  DOBRA
LEK    KIP  LUIGINO  DONG
DINAR  LAT  PATACA  LOTI
FRANC  ARIARY  RUPIAH  RIAL
ESCUDO RINGGIT  KWACHA
COLON  CORDOBA
POUND  NAIRA  RIAL
KROON  WON  LIRA
QUETZAL BALBOA  RAND
KRONE  KINA  LEONE
RUPEE  ZLOTY  BHD
KRONA  GUARANI